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1. Software Overview 

1.1. Software Introduction 

AnalyZis is a professional Electrochemical Impedance Spectroscopy (EIS) analysis software 

developed by Shanghai Zhiyuan Suanneng New Energy Technology Co., Ltd. The software 

integrates three core functional modules: Kramers-Kronig Relation (KKR) verification, Distribution 

of Relaxation Times (DRT) analysis, and Equivalent Circuit Modeling (ECM), providing 

electrochemical researchers with a comprehensive data analysis solution. 

Employing advanced algorithms and a user-friendly graphical user interface, AnalyZis supports the 

import of multiple data formats and offers rich visualization tools and detailed statistical reports. It 

aims to assist users in gaining a deeper understanding of the kinetic processes and interfacial 

characteristics of electrochemical systems. 

1.2. Main Functional Features 

 Core Analysis Modules 

1) KKR Analysis: Verifies the causality, linearity, and stability of EIS data based on the 

Kramers-Kronig relation. 

2) DRT Analysis: Reveals the kinetic processes of electrochemical systems through 

distribution of relaxation times analysis. 

3) ECM Analysis: Provides equivalent circuit model fitting and parameter optimization 

functions. 

 Data Processing Features 

1) Supports the import of various data formats including CSV, TXT, and Excel. 

2) Automatically detects file encoding and delimiters. 

3) Offers data range screening and filtering capabilities. 

4) Provides real-time data preview and validation. 

 Visualization Features 

1) Displays high-quality Nyquist and Bode plots. 

2) Enables interactive chart operations (zooming, panning, resetting). 

3) Manages multi-subplot layouts. 

4) Customizes chart styles and themes. 

 Output and Export Features 

1) Generates detailed data analysis reports. 

2) Exports charts in multiple formats (PNG, SVG, JPEG). 

3) Offers data table export functionality. 
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4) Provides complete ECM parameter statistical information. 

 User Interface Characteristics 

1) Multilingual support (Chinese, English). 

2) Light/dark theme switching. 

3) Intelligent tooltips and help systems. 

4) Intuitive parameter setting interface. 

1.3. System Requirements 

 Minimum Configuration Requirements 

1) Operating System: Windows 10 or higher. 

2) Processor: Intel Core i5 or equivalent AMD processor. 

3) Memory: 8 GB RAM. 

4) Hard Disk Space: 2 GB available space. 

5) Display: 1024×768 resolution 

 Recommended Configuration 

1) Operating System: Windows 11. 

2) Processor: Intel Core i7 or higher performance processor. 

3) Memory: 16 GB RAM or higher. 

4) Hard Disk Space: 5 GB available space (SSD recommended). 

5) Display: 1920×1080 or higher resolution. 

6) Graphics Card: Dedicated graphics card (for accelerated graphics rendering) 

1.4. Installation and Startup 

 Installation Steps 

1) Download the ZIP compressed package from the official website. 

2) Extract the package to the specified directory for installation-free operation. 

 

 Startup Method 

1) Double-click the AnalyZis_EIS_Tool_vX.XX.XXE.exe executable file in the software 

directory to launch the "AnalyZis" software. 

2) If permission issues arise, right-click the executable file and select "Run as administrator." 

 

 

Note: New users are advised to read the operational guidelines in subsequent chapters to fully uti lize the 

software's features. For installation or startup issues, contact technical support. 
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2. Quick Start 

2.1. Interface Layout Introduction 

AnalyZis employs an intuitive, adjustable three-partition interface design to provide users with 

an efficient workflow. 

 Main Interface Structure 

 

I. Left Panel: 

- Data table display area. 

- Raw data and fitting results tables. 

- Real-time data display and filtering functions. 

- Data statistical information display. 

II. Central Panel： 

- Chart visualization area. 

- Interactive chart operation controls. 

- Circuit diagram and statistical information display area (ECM page). 

III. Right Panel: 

- Parameter setting area. 

- Analysis parameter configuration. 

- Algorithm option settings. 

- Execution control buttons. 

- Nyquist/Bode chart display and operation area (ECM page). 

 Functional Tabs 
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The software top bar contains three main functional tabs: 

 

- KKR: Kramers-Kronig relation verification 

- DRT: Distribution of relaxation times analysis 

- ECM: Equivalent circuit model fitting. 

 Status Bar Information 

The bottom status bar displays: 

 

- Current loaded file path. 

- Operation status prompts. 

- Operation time display. 

- Analysis progress indicator. 

2.2. Basic Operational Procedures 

I. Data Import 

1) Click on "File" → "Import" → "Import EIS Data" in the menu bar. 

2) Select the EIS data file (supports CSV, TXT, Excel files). 

3) Click "OK" to complete the import. 

 

File Format Requirements: 

- Must contain three columns of data: Frequency (Hz), Impedance Real Part, 

Impedance Imaginary Part. 

- Supports files with or without headers. 

- Delimiters supported include commas, semicolons, and tabs. 

II. Data Preview 

1) Check if the data in the left table is correctly loaded. 

2) Verify if the Nyquist plot in the central area is displayed normally. 

3) Confirm data range and unit settings. 

III. Select Analysis Mode 

Based on the analysis objective, select the corresponding tab: 

 KKR Analysis Mode 
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1) Set KKR parameters in the right panel: 

a) Select data usage range (All/BelowX/RangeF). 

b) Set cutoff threshold (recommended 0.3-0.7). 

c) Select fitting type (Complex/Real/Imag). 

2) Click the "Analyze KKR" button to begin analysis. 

 DRT Analysis Mode 

1) Set DRT parameters: 

a) Select discretization function type. 

b) Select regularization method. 

2) Click the "Analyze DRT" button to begin analysis. 

 ECM Analysis Mode 

1) Input equivalent circuit formula (e.g., R+(R/Q)+W). 

2) Set initial values and constraints for component parameters. 

3) Click the "Fit" button to begin fitting. 

IV. Result Interpretation 

1) View the fitting curve and raw data comparison in the chart area. 

2) Analyze fitting parameters and residual data in the left table. 

3) Assess fitting quality using statistical indicators (χ², AIC, BIC, etc.). 

V. Result Export 

1) Click on "File" → "Export" in the menu bar. 

2) Select export content: 

a) Data table (CSV format). 

b) Chart images (PNG/SVG/JPG formats). 

3) Choose the save path and confirm the export. 

2.3. Shortcut Key Descriptions 

 Global Shortcut Keys 

Shortcut Key Function Description Usage Scenario 

Ctrl + I Import EIS data Quickly start a new analysis 

F1 Open help documentation Obtain usage assistance 

Ctrl + Q Exit the program Safely close the software 

 Chart Operation Shortcut Keys 

Shortcut Key Function Description Usage Scenario 

Mouse Scroll Wheel Chart zooming Adjust view range 

Double-click Mouse Reset view Restore original display range 
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 Navigation Shortcut Keys 

Shortcut Key Function Description Usage Scenario 

Ctrl + Tab Switch tabs Toggle between KKR/DRT/ECM 

 Usage Recommendations 

Recommended Workflow for Beginners 

- First-time Use: Follow the five-step procedure in Section 2.2 to complete a full 

analysis. 

- Familiarize with Interface: Spend 10 minutes exploring the functions of each area. 

- Try Different Modes: Experience the KKR, DRT, and ECM analysis modes 

respectively. 

- Select Parameters Based on Prompts: Choose appropriate parameters based on the 

tooltip information displayed upon mouse hover. 

- Consult Help: Use the F1 shortcut key to view detailed help information at any time. 

Efficiency Enhancement Tips 

- Use shortcut keys instead of mouse operations. 

- Utilize the data filtering function to focus on key data ranges. 

- Regularly export results to prevent data loss. 

  

 

 

 

Tip: New users are advised to practice with the sample data provided in the "examples" folder in the installation 

directory before processing actual experimental data. 
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3. Data Import 

3.1. Supported File Formats 

AnalyZis supports a variety of common data file formats to meet the output requirements of 

different instruments and software: 

 Main Supported Formats 

Format Type Extension Description Applicable Scenarios 

CSV Files .csv 
Comma-Separated 

Values file 
Most universal data exchange format 

Text Files .txt Plain text format file Supports multiple delimiters 

Excel Files .xlsx, .xls Excel spreadsheet Directly export data from Excel 

 Format Compatibility Notes 

Delimiter Support: Automatically recognizes commas (,), semicolons (;), tabs (\t), spaces ( ), 

and other delimiters. 

Encoding Support: UTF-8, GBK, GB2312, ASCII, UTF-16, and other common encoding 

formats. 

Precision Support: Supports single and double precision floating-point numbers. 

3.2. Data Format Requirements 

 Basic Data Structure Requirements 

1) Required Data Columns (in order): 

 Column 1: Frequency (Frequency, Hz) 

 Column 2: Real part of impedance (Z' or Z_real, Ω) 

 Column 3: Imaginary part of impedance (Z'' or Z_imag, Ω) 

2) Optional Data Columns: 

 Phase angle (Phase, °) 

 Magnitude of impedance (|Z|, Ω) 

 Other auxiliary parameters (temperature, voltage, etc.) 

 File Format Examples 

1) Example 1: CSV file with header 
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2) Example 2: Text file without header 

 

3) Example 3: European format separated by semicolons 

 

4) Example 4: Tab-separated file 

 

 Data Quality Requirements 

 Data Integrity: No missing values or empty rows. 

 Numerical Validity: All data must be valid numerical values. 

 Frequency Order: Recommended to be arranged in descending order (high frequency to 

low frequency). 

 Data Volume Requirement: At least 3 valid data points are required. 

3.3. Detailed Import Steps 

 Import Process 

1) Click on the main menu: File → Import → Import EIS Data. Or use the shortcut: Ctrl + 

I. 

2) In the file selection dialog, choose the target file and click "Open" to start the import. 

3) The software automatically detects the file encoding and delimiter, and recognizes whether 

there is a header. 
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 Successful Import Notification 

 The file path is displayed on the left side of the status bar. 

 "Successfully Imported File" is displayed in the middle of the status bar. 

 The imported data is displayed in the table on the left side of the KKR page. 

 The Nyquist plot is automatically drawn in the central chart area. 

3.4. Common Import Issues and Solutions 

 Issue 1: Encoding Error Causing Garbled Text 

 Symptoms: Chinese characters appear as garbled text 

 Solutions: 

- Try manually selecting the encoding format: UTF-8 or GBK. 

- Save the file as UTF-8 format using a text editor. 

- Check if the file is damaged. 

 Issue 2: Delimiter Recognition Error 

 Symptoms: Data columns are misaligned or merged. 

 Solutions: 

- Check if the delimiters in the file are consistent. 

- Avoid using mixed delimiters. 

 Issue 3: Inconsistent Data Format 

 Symptoms: Some data cannot be recognized as numerical values 

 Solutions: 

- Check for non-numeric characters in the data. 

- Ensure consistent decimal point format (use a period . instead of a comma ,). 

- Remove extra spaces or special characters. 

 Issue 4: Header Recognition Error 

 Symptoms: The first row of data is recognized as a header or vice versa. 

 Solutions: 

- Check if the first row contains numerical data. 

 Issue 5: Abnormal Data Range 

 Symptoms: Abnormal chart display or obvious data point errors. 

Solutions: 

- Check if the frequency range is reasonable (typically 10mHz-100kHz). 

- Verify if the impedance values are within the expected range. 

- Check if the imaginary part is negative (capacitive characteristic).  

 Advanced Troubleshooting 
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 Log File Inspection 

If the import fails, check the log file. Open the log viewer: Log → View Log, or check the 

/log/analyZis.log file in the installation directory, and handle it accordingly based on the error 

information. 

 Example File Testing 

If unsure about the file format, use the example files provided by the software for testing. The 

example file path is: installation directory /examples/. Compare the format differences between 

the example files and your own files. 

 Technical Support Contact 

If the issue cannot be resolved, contact technical support through Help → Feedback. Provide 

the error log and example files, and describe the specific issue phenomenon and operation steps. 

 Best Practice Recommendations 

 File Preparation Recommendations 

- Preprocessing: Check the file format using a text editor before importing. 

- Backup: Back up the original data file before importing. 

- Standardization: Use CSV format and UTF-8 encoding whenever possible. 

- Simplification: Remove unnecessary columns and comment rows. 

 Data Validation Checks 

- Verify if the number of imported data points matches expectations. 

- Check if the frequency range is correct. 

- Verify if the impedance values are within a reasonable range. 

- Check if the chart display is normal. 

 

 

Note: Correct data import is the foundation for subsequent analysis. It is recommended to ensure the accuracy of 

data import. For complex issues, contact technical support. 



上 海 智 源 算 能 AnalyZis - EIS Analysis Software User Manual 
2025-10-12 V1.01WWW.AI-EIS.COM

 

13 
 

4. KKR Verification Function 

 

4.1. Introduction to Kramers-Kronig Relation (KKR) 

 Basic Concept 

The Kramers-Kronig relation (KKR) is a fundamental mathematical tool in electrochemical 

impedance spectroscopy (EIS) analysis, used to verify the causality, linearity, and stability of EIS 

data. This relation describes the intrinsic mathematical connection between the real and imaginary 

parts of complex impedance and is an important basis for judging the quality of EIS data. 

 Mathematical Principle 

The basic form of the KKR relation is: 

 𝑍′(𝜔) =  
2

𝜋
∫

𝑥𝑍′′(𝑥)

𝑥2−𝜔2 𝑑𝑥
∞

0
 

 𝑍′′(𝜔) =  −
2𝜔

𝜋
∫

𝑍′(𝑥)

𝑥2−𝜔2 𝑑𝑥
∞

0
 

Where: 

 Z'(ω) is the real part of impedance.  

 Z''(ω) is the imaginary part of impedance. 

 ω is the angular frequency. 

 Physical Significance 

 Causality: The system's response cannot precede the excitation. 

Linearity: The system's response is proportional to the excitation. 

Stability: The system can return to equilibrium after perturbation. 
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Finiteness: Impedance is finite as frequency approaches zero and infinity. 

 Application Value 

 Data Verification: Identify measurement errors and experimental artifacts. 

Quality Assessment: Quantify the reliability of EIS data. 

Interpolation and Extrapolation: Predict the complete impedance spectrum within a limited 

frequency range. 

Model Verification: Test the rationality of equivalent circuit models 

4.2. Parameter Setting Details 

 

 Data Range Selection 

 Use Data Options 

Option Description Applicable Scenarios 

All Use all frequency data 
High data quality, reliable across the entire 

frequency band 

BelowX 
Use only data with negative 

imaginary parts 

Exclude the influence of high-frequency 

inductive effects 

RangeF Custom frequency range Manually select the optimal data interval 

 Frequency Range Parameters 

  From：Lower frequency limit setting (Hz)  

  To：Upper frequency limit setting (Hz) 

 Algorithm Parameter Settings 

 Cut Off Threshold（0.0-1.0） 
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Function:  Controls the strictness of the fit. 

Low Value (0.1-0.3):  Strict fit, small residuals but may overfit. 

Medium Value (0.4-0.6):  Balanced fit, recommended for most cases. 

High Value (0.7-0.9):  Loose fit, strong anti-noise capability. 

 MAX Elements Quantity 

Function:  Controls the number of basis functions. 

Few (50-100):  Fast calculation, suitable for simple systems. 

Medium (100-200):  Balanced precision and speed. 

Many (200-300):  High precision, suitable for complex systems 

 Fit Type Selection 

 Complex Fit 

Simultaneously fits the real and imaginary parts, the most stringent verification standard, 

recommended for high-quality data. 

 Real Fit 

Fits only the real part data, suitable for situations where the imaginary part has high noise, 

and calculation speed is faster. 

 Imag Fit 

Fits only the imaginary part data, suitable for situations where the real part has high noise, 

and for special application scenarios. 

 Additional Options 

 Add Series Capacity 

On: Add a series capacitor to the equivalent circuit. 

Off: Do not use a series capacitor. 

Choose based on the specific electrochemical system. 

 Z Units Setting 

μΩ: Microohms, suitable for low-impedance systems. 

mΩ: Milliohms, suitable for medium-impedance systems. 

Ω: Ohms, suitable for high-impedance systems. 

4.3. Analysis Result Interpretation 

 Visual Results 

 Nyquist Plot Display 
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Original Data Points: Displayed as blue dots. 

KKR Fit Curve: Displayed as an orange curve. 

Degree of Coincidence: Reflects the extent to which the data conforms to the KKR relation. 

 Residual Analysis Plot 

 

Real Part Residual: Green curve, displays the real part fitting error. 

Imaginary Part Residual: Yellow curve, displays the imaginary part fitting error. 

Error Range: Usually ±5% is considered an acceptable limit. 

 Result Judgment Criteria 

 Passed KKR Verification (Meets Requirements) 

Residuals are within ±5%, and the fit curve closely coincides with the original data. 

 Failed KKR Verification (Problems Exist) 

Residuals exceed ±5%, and there is a significant systematic deviation. Experimental conditions 

or data quality need to be checked. 

4.4. Application Cases 

 Case 1: EIS Data Verification for Lithium-Ion Batteries  

- To be updated 
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 Case 2: Impedance Analysis of Fuel Cells  

- To be updated 

 Case 3: Impedance Verification for Corrosion Systems 

- To be updated 

 Advanced Application Techniques 

- To be updated 

 Notes 

- To be updated 
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5. DRT Analysis Function 

 

5.1. Introduction to the Principle of Relaxation Time 

Distribution 

 Basic Concepts 

Distribution of Relaxation Times (DRT) analysis is a powerful technique for interpreting 

electrochemical impedance spectra, capable of decomposing complex impedance responses into 

relaxation processes across different time scales. Compared to traditional equivalent circuit models, 

the DRT method offers a model-free analytical approach, providing more intuitive insights into the 

physical and chemical processes within electrochemical systems. 

 Mathematical Principles 

  Z(𝜔)  =  𝑅∞ +  ∫
𝛾(𝜏)

1+𝑗𝜔𝜏
𝑑(ln 𝜏)

∞

0
+ 𝑗𝜔𝐿  

Among which: 

 Z(𝜔) is the complex impedance 

 𝑅∞ is the high-frequency resistance 

 γ(τ) is the distribution function of relaxation time 

 τ is the relaxation time 

 L is the inductive component 

 Physical Significance 

 Multi-Time Constant Analysis: Identifying multiple relaxation processes coexisting in 
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the system. 

 Process Separation: Resolving overlapping impedance arcs into distinct relaxation 

processes. 

 Kinetic Information Extraction: Obtain characteristic times and relative contributions 

of each process. 

 Artifact Identification: Distinguish between genuine physical processes and 

measurement artifacts. 

 Core Advantages 

 Model-Free Assumption: Does not rely on preset equivalent circuit models. 

 High Resolution: Capable of distinguishing processes with closely spaced time constants. 

 Intuitive Visualization: Displays relaxation process distributions in the form of peak-

shaped graphs. 

 Quantitative Analysis: Provides the integral intensity and characteristic time for each 

process. 

5.2. Detailed Explanation of Parameter Settings 

 

 Selection of Discretization Functions 

 Gaussian function 

It has good smoothness, strong noise resistance, symmetric peak shape, moderate resolution, 

and is suitable for most application scenarios. 

 C2 Matern (second order) 

Recommended for use, it balances accuracy and computational efficiency, offers high 

resolution, good noise resistance, and is suitable for most electrochemical systems. 

 C4 Matern (fourth order) 

High resolution, capable of distinguishing close time constants, sensitive to noise, requires 

high-quality data. 



上 海 智 源 算 能 AnalyZis - EIS Analysis Software User Manual 
2025-10-12 V1.01WWW.AI-EIS.COM

 

20 
 

 Piecewise Linear Function 

Most flexible, adaptable to various distribution shapes, but requires more computational 

resources. 

 Data Type Selection 

 Complex data 

Using complete complex impedance information provides the maximum amount of 

information and is recommended. It requires both real and imaginary data to be of good 

quality. 

 Real part only 

Using only the real part of impedance data, suitable for situations with significant noise in 

the imaginary part, with lower resolution. 

 Imaginary part only 

Using only the imaginary part of impedance data, suitable for situations with significant 

noise in the real part, for special application scenarios. 

 Inductance Processing Options 

 Includes Inductance 

Retains high-frequency inductance components, suitable for systems with significant 

inductive effects. 

 Exclude inductance 

Recommendation: Eliminate the influence of inductance and focus on the electrochemical 

process. 

 Ignore high frequency 

Directly discard high-frequency data affected by inductance, simple but may result in 

information loss. 

 Regularization method selection 

 Generalized cross-validation 

Recommendation, use the GCV method to determine parameters 

 L-curve method 

Use the L-curve to determine parameters 

 Manual setup 

Manual input of regularization parameters 

 Regularization parameter settings 
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When the regularization method is set to "Manual Setting", the regularization parameters can 

be manually configured: 

 Function: Controls the smoothness of the fit 

 Small value (1e-6): Precise fitting but may lead to overfitting 

 Median value (1e-4): Balances fitting and smoothing 

 Large value (1e-2): Results are smooth but may underfit 

 Peak width coefficient setting 

 Function: Controls the width of the radial basis function 

 Small value (0.3-0.4): Narrow peak, high resolution but sensitive to noise 

 Medium value (0.5): Balanced choice, recommended for most situations 

 Large value (0.6-0.7): Broad peak, strong noise resistance but low resolution 

5.3. Application cases 

 Case 1: DRT analysis of lithium-ion batteries 

To be updated 

 Case 2: DRT Analysis of Fuel Cells 

To be updated 

 Case 3: DRT Analysis of Corrosion System 

To be updated 

 Advanced Analysis Techniques 

To be updated 

 Precautions 

To be updated 
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6. ECM Fitting Function 

 

6.1. Introduction to the Principles of Equivalent 

Circuit Models 

 Basic Concepts 

The Equivalent Circuit Model (ECM) is the most classic and widely used method in electrochemical 

impedance spectroscopy analysis. This approach describes the impedance response characteristics 

of electrochemical systems by constructing equivalent circuits composed of basic circuit elements, 

transforming complex electrochemical processes into intuitive combinations of circuit components. 

 Mathematical Foundation 

ECM analysis is based on the series and parallel impedance rules in circuit theory: 

 Series Impedance: 

 Z𝑡𝑜𝑡𝑎𝑙  =  𝑍1  +  𝑍2  + 𝑍3  +  ⋯ 

 Parallel Impedance: 

 
1

𝑍𝑡𝑜𝑡𝑎𝑙
 =  

1

𝑍1
 +  

1

𝑍2
 +

1

𝑍3
 +  ⋯ 

 

 Core Components and Their Physical Significance 

Circuit components Symbol Impedance Formula Physical Meaning 

Resistance R Z = R Ohmic resistance, charge transfer resistance 

Capacitance C Z = 1/(jωC) Ideal capacitor, interfacial double-layer 
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Circuit components Symbol Impedance Formula Physical Meaning 

charging 

Inductance L Z = jωL 
Ideal inductor, wire or electrode inductive 

reactance 

Constant phase element Q Z = 1/(Q·(jω)ⁿ) 
Non-ideal capacitance, dispersive interfacial 

process 

Warburg element W Z = 20.5·σ/(jω)0.5 
Diffusion impedance, mass transfer limited 

process 

 Circuit Syntax Rules 

 Basic Connection Symbols: 

+ :  Series Connection 

/ :  Parallel connection 

( ) : Grouping operation, defining operation precedence 

 Formula example 

1) Simple RC circuit: R+C 

 

2) Randles circuit: R+R/C 

 

3) Circuit with diffusion: R+R/(C+W) 

 

4) Complex Circuit: R+R/C+R/(Q+W) 
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6.2. Parameter Fitting and Optimization 

 Parameter Constraint Setting 

 Fixed parameters 

Known parameters: Fixed known physical constants 

Invariant parameters: Parameters fixed and unchanged under varying conditions 

Simplified fitting: Reduce the number of parameters to be optimized 

 Initial value setting strategy 

 Automatic estimation 

Resistance value: Estimated from the high-frequency intercept of the Nyquist plot 

Capacitance value: Estimated from the characteristic frequency 

n value: Default 0.8-0.9 (CPE element) 

 Manual setting 

Experience value: Based on experience with similar systems 

Physical significance: Reasonable range estimated according to theory 

Multiple Attempts: Verifying Result Stability with Different Initial Values 

 Quality Control of Fitting 

 Residual Analysis: Examining the Distribution of Fitting Errors 

 Parameter Rationality: Verification of Physical Significance Rationality 

6.3. Interpretation of Analysis Results 
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 Evaluation of Statistical Indicators 

 Chi-square: Chi-square value (χ²) 

Measures the degree of difference between observed and fitted values. 

Formula: 

χ2  =  ∑
(𝑍𝑜𝑏𝑠 − 𝑍𝑓𝑖𝑡)

2

𝜎2
 

Evaluation Criteria: 

Ideal Value: χ² ≈ Degrees of Freedom (n - p) 

χ² ≫ n-p: Model is inappropriate or errors are underestimated 

χ² ≪ n-p: Error overestimation or overfitting 

Where, n: number of data points, p: number of parameters 

 Reduced Chi-square: Reduced chi-square value (χ²/ν) 

The chi-square value after considering degrees of freedom, used to compare models of 

different complexities. 

Formula: 

χ2

ν
=  

χ2

𝑛 − 𝑝
 

Evaluation criteria: 

Ideal value: ≈1.0 

Acceptable range: 0.5 - 2.0 

 AIC: Akaike Information Criterion 

The difference (ΔAIC) between other models and the model with the minimum AIC value 

can be calculated to assist in judgment. 

Formula: 

AIC = 2k − 2 ln 𝐿 

Where, k: number of parameters, L: maximum likelihood value. 

Evaluation Criteria: 

ΔAIC < 2: No significant difference between models 

ΔAIC = 2-6: Some difference 

ΔAIC > 6: Significant difference 

Smaller values indicate a better model 

 AICc: Corrected Akaike Information Criterion 

Correct small sample data to prevent overfitting. Use AICc instead of AIC when n/k < 

40. When n is sufficiently large, AICc ≈ AIC. 
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Formula: 

AICc = AIC +  
2𝑘 ∙ (𝑘 + 1)

𝑛 − 𝑘 − 1
 

Where k: number of parameters, n: sample size. 

 BIC: Bayesian Information Criterion 

It favors simpler models more than AIC, is more sensitive to large sample data, imposes 

stricter penalties on complex models, and is suitable for situations with larger sample 

sizes. A smaller value indicates a better model. 

Formula: 

BIC = k ∙ ln(𝑛) − 2 ln(𝐿) 

 Std Dev: Residual Standard Deviation 

Used to measure the fitting accuracy, it should be comparable to the instrument's 

measurement precision. A smaller value indicates a more precise fit, and the ideal value 

should be close to the measurement error. 

Formula: 

𝛔 =  √
∑(𝑍𝑜𝑏𝑠− 𝑍𝑓𝑖𝑡)

2

𝑛−𝑝
        

 Avg Relative Error: Average Relative Error 

Used for fitting quality evaluation. 

Formula: 

ARE =  
1

𝑛
 × ∑ |

𝑍𝑜𝑏𝑠 − 𝑍𝑓𝑖𝑡

𝑍𝑜𝑏𝑠
| × 100% 

Evaluation Criteria: 

< 5%: Excellent 

5-10%: Good 

10-20%: Acceptable 

> 20%: Needs Improvement 

Comprehensive consideration of real and imaginary part errors 

 Graphical Evaluation 

 Nyquist Plot Fitting 

Data Points: Experimental Measurements (Scatter Points) 

Fitted curve: Model calculated values (solid line) 

Degree of overlap: Visually displays the quality of fit 
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 Residual analysis 

Real part residual: (Z'_exp - Z'_fit)/Z'_exp 

Imaginary part residual: (Z''_exp - Z''_fit)/Z''_exp 

Acceptable error: Generally <5% 

 Interpretation of the Physical Meaning of Parameters 

Resistor Component (R) 

- Rs: Solution resistance, reflecting the conductivity of the electrolyte 

- Rct: Charge transfer resistance, reflecting reaction kinetics 

- Rfilm: Film resistance, reflecting surface film impedance 

Capacitive elements (C, Q) 

- Cdl: Electric double-layer capacitance, reflecting the electrode/solution interface 

- Q: Constant phase element, reflecting non-ideal capacitive behavior 

- n value: Dispersion coefficient (0-1), reflecting interface uniformity 

Diffusion element (W) 

- σ: Warburg coefficient, reflecting the diffusion rate 

 Circuit model validation 

KKR Verification 

- Check if the fitting results comply with the Kramers-Kronig relations 

- Verify the causality, linearity, and stability of the model 

Physical plausibility 

- Whether parameter values are within physically possible ranges 

- Whether temperature/concentration dependencies align with theoretical expectations 

- Whether it is consistent with the results of other measurement techniques 

Model comparison 

- Compare the goodness of fit of different circuits 

- Model selection using AIC/BIC 

- Avoid over-parameterization (overfitting) 

6.4. Application cases 

 Case 1: ECM Analysis of Lithium-ion Batteries 

To be updated 

 Case 2: ECM Analysis of Fuel Cells 

To be updated 

 Case 3: ECM Analysis of Corrosion System 

To be updated 

 Advanced Application Techniques 
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To Be Updated 

 Precautions 

To Be Updated 
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7. Data Visualization 

7.1. Nyquist Curve Operation Guide 

 

 Basic Concepts 

The Nyquist plot is the most commonly used visualization tool in electrochemical impedance 

spectroscopy analysis, with the real part of impedance (Z') as the horizontal axis and the negative 

imaginary part (-Z'') as the vertical axis, intuitively displaying the characteristic shape of the 

impedance response. 

 Interactive Operation Function 

 Zoom Control 

Mouse Wheel: Zoom centered on the cursor for detailed viewing of specific areas 

Double Click: Reset to the original view and restore the global perspective 

 Display 

 Data Series 

Raw Data: Scatter Plot Display 

Fitted curve: Line graph display 

Residual display: Shows the distribution of fitting residuals 

 Data point interaction 

 Hover Tooltip 

Auto Display: Shows the most recent data point information when hovering 
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Information Content: Frequency, Real Part, Imaginary Part, Residual 

7.2. Bode Plot Operation Guide 

 

 Introduction to Chart Types 

The Bode plot uses frequency as the horizontal axis (logarithmic scale) to display the variation of 

impedance magnitude (|Z|) and phase angle (θ) with frequency. 

 Amplitude-frequency characteristic diagram 

Vertical axis: Impedance magnitude |Z| (logarithmic scale) 

Display content: Variation of impedance magnitude with frequency 

Application: Identifying Dominant Processes in Different Frequency Ranges 

 Phase-Frequency Characteristic Diagram 

Vertical Axis: Phase Angle θ (Linear Scale) 

Display Content: Phase vs. Frequency 

Application: Determining Capacitive/Inductive Characteristics of Processes 

 Multi-Axis Display Control 

 Dual Y-axis configuration 

Left Y-axis: Impedance magnitude |Z| (logarithmic scale) 

Right Y-axis: Phase angle θ (linear scale) 

Auto Alignment: Automatic optimization and alignment of dual-axis scales 

 Axis Activation Control 

Click to Toggle: Click on axis labels to activate the corresponding axis 

Visual Feedback: Activate axis label highlighting 

Zoom Synchronization: Synchronous adjustment of dual Y-axes during X-axis zoom 

 Frequency Range Management 

 Logarithmic coordinate characteristics 
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Automatic scaling: Automatically sets the logarithmic scale based on the data range 

Scale density: Controls the density of major and minor tick marks 

 Range Optimization 

Auto-Adaptation: Automatically selects the optimal display range based on data 

Key Areas: Can focus on specific frequency intervals 

Full Range Display: One-click to show the complete frequency range 

 Data Comparison Function 

 Multiple Data Sets Overlay 

Simultaneous Display: Multiple sets of Bode plots can be displayed on the same chart. 

Color Differentiation: Different data series are distinguished by different colors. 

Legend Management: Automatically generates an interactive legend. 

 Difference Display 

Difference Mode: Displays the differences between two sets of data 

Ratio Mode: Shows the impedance change ratio 

Reference Line: Add baseline reference comparison 
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8. Data and Chart Export 

8.1. Analysis Data Export 

 Export Format 

 CSV Format 

Strong versatility, text-based format, moderate file size, maintains data precision, supports 

scientific notation, and is compatible with almost all software. 

Example of file structure: 

 

 Data content 

 KKR data export 

Complete data: includes raw data, fitting results, and residuals 

 DRT data export 

Complete data: includes relaxation time and relaxation time distribution function 

 ECM Data Export 

Metadata: Analysis parameters, raw data, fitted data, errors 

Statistical Metrics: χ², AIC, BIC, and other goodness-of-fit indicators 

Parameter Information: ECM Formula, Impedance Formula, Fitted Parameter Values 

Unit Information: Unit Labels for All Data 

8.2. Chart Export 

 Export Format Selection 

 Image Format 

Format Resolution File Size Applicable Scenarios 

PNG High (300-600 DPI) Medium Paper publication, report creation 

SVG Infinite scaling Small Vector editing, web usage 

JPEG Adjustable Small Webpage preview, quick sharing 
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 Best Practice Recommendations 

 Visualization Strategy 

Select Appropriate Chart Types: Choose Nyquist or Bode plots based on analysis objectives 

Optimize Display Range: Adjust coordinate ranges to highlight key features 

Use consistent styles: Maintaining style consistency across multiple charts facilitates 

comparison 

 Interactive techniques 

Make full use of zooming: Combine global view with detailed inspection 

Use Data Tips: Quickly obtain data information by utilizing hover prompts. 

 Export Optimization 

Choose the Appropriate Format: Select the best file format based on the intended use. 

Balance quality and size: Achieve a balance between image quality and file size 

Include necessary information: Ensure the exported chart contains all essential information 

 

Note: Effective data visualization is a key aspect of impedance analysis. It is recommended to optimize the chart 

display to make data features clearer and more comprehensible. 
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9. Advanced Features 

9.1. Unit System Settings 

 Unit System Options 

Unit Symbol 
Conversion 

relationship 
Applicable Scenarios 

Micro-Ohm μΩ 1 μΩ = 10⁻⁶ Ω 
Low impedance systems (batteries, 

supercapacitors) 

Milliohm mΩ 1 mΩ = 10⁻³ Ω Medium impedance system (fuel cell) 

Ohm Ω Base unit 
High impedance systems (coatings, corrosion 

studies) 

 Unit Conversion Function 

Automatic Conversion: Adjusts all displayed values automatically based on selection 

Data Consistency: Ensure analysis results are consistent with unit settings 

 

 Scope of Unit Settings Impact 

Data Display: All impedance values in tables and charts, including KKR, DRT, and ECM 

pages 

Analysis Results: Fitting parameters and statistical metrics 

Export Content: Unit consistency for all exported data 

9.2. Multilingual Support 

 Supported Languages List 

Language Code Level of Support Features 

English en Full support Default language, accurate terminology 

Simplified 

Chinese 
zh Full support Localization of Professional Terminology 

 Real-time Language Switching 

Menu Selection: Switch directly through the language menu 

Configuration File: Modify the default language by editing the /config.ini/config.ini file in 

the program directory 

 Switch Effect 
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Immediate Effect: No software restart required 

Complete Switchover: All interface elements switch simultaneously 

Memory Function: Remember the user's language preference 

9.3. Log Management 

 Log Level Settings 

Level Description Applicable Scenarios 

DEBUG Debug Information 
Development testing, detailed operational 

information 

INFO General information 
Normal operation log, recommended for 

production environment 

WARNING Warning message Potential Issue Alert 

ERROR Error Message Operation failed, attention required 

CRITICAL Critical error System severe failure 

 Log File Management 

Rotation by Size: Maximum single file size 2MB 

Backup Count: Retain the latest 5 backup files 

 Built-in log viewer 

View logs through the log menu to monitor the latest log information in real-time, including 

complete content at all log levels, and export log files to a specified directory for storage. 

 Log file location 

Default path: Installation directory /log/analyZis.log 
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10. Contact 

If you encounter any difficulties while using the AnalyZis EIS analysis software, or have any 

suggestions and feedback, please contact us. 

 

 Email: 

Support@AI-EIS.com 

 Website: 

https://www.ai-eis.com/ 

 Feedback: 

https://www.ai-eis.com/AnalyZis_feedback.html 

 Address: 

Room 806, Building B, Lingang Science and Technology Center, No. 333 Haiyang First 

Road, Lingang New Area, China (Shanghai) Pilot Free Trade Zone 

 

 

Please follow our official account and add the corporate WeChat contact to receive the latest product 

information and technical support as soon as possible. 

 

                    

WeChat Official Account                         Corporate WeChat 

 

 

 

 

 

mailto:Support@AI-EIS.com
https://www.ai-eis.com/
https://www.ai-eis.com/AnalyZis_feedback.html
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Copyright Information 

Copyright Notice 

Copyright ©2025 Shanghai Zhiyuan Suanneng New Energy Technology Co., Ltd. 

All rights reserved. 

This document and its contents are protected by international copyright, trademark, and 

intellectual property laws. No part of this document may be reproduced, transmitted, distributed, 

modified, or used in any form or by any means (electronic, mechanical, photocopying, recording, 

or otherwise) without the prior explicit written permission of the copyright owner. 

Product Information 

Software Name: AnalyZis EIS Analysis Software 

Version: V1.04.00R 

Document Version: 1.01 

Release Date: October 12, 2025 

Document ID: AIEIS-ANZ-DOC-20251012-V1.01 

Trademark Statement 

AnalyZis® is a registered trademark of Shanghai Zhiyuan Suanneng New Energy Technology 

Co., Ltd. 

All other trademarks, trade names, service marks, and product names mentioned in this document 

are the property of their respective owners. 

License Information 

I. Usage License 

This user manual is to be used only with a legally authorized copy of AnalyZis software. Any 

user who installs or uses this software thereby agrees to comply with these license terms. 

II. Copying License 

Permission is granted to make copies of this manual for backup purposes, provided that all 

copies include the complete copyright notice and ownership information. 



上 海 智 源 算 能 AnalyZis - EIS Analysis Software User Manual 
2025-10-12 V1.01WWW.AI-EIS.COM

 

38 
 

III. Prohibited Actions 

The following actions are strictly prohibited: 

 Removing or altering any copyright notices or trademark logos 

 Reverse engineering, decompiling, or disassembling the software 

 Unauthorized distribution, rental, lending, or sublicensing 

Limitation of liability 

I. Disclaimer 

This software and documentation are provided "as is" without any express or implied 

warranties, including but not limited to the implied warranties of merchantability, fitness for a 

particular purpose, and non-infringement. 

II. Scope of Liability 

Under no circumstances shall Shanghai Zhiyuan Suanneng New Energy Technology Co., Ltd. 

be liable for any direct, indirect, incidental, special, consequential, or punitive damages arising 

from the use or inability to use this software and documentation, even if advised of the 

possibility of such damages. 

III. Technical Updates 

The company reserves the right to modify product specifications and documentation content at 

any time without prior notice. 

Important Notice 

I. Export Control 

This software and technical data are subject to Chinese export control laws and regulations. 

Users agree to comply with all applicable export control laws and regulations, and shall not 

directly or indirectly export or transfer the software or technical data to any country or region 

subject to export control restrictions, or to any restricted end-user. 

 

 Special thanks to all partners and users who contributed to the development and testing of AnalyZis 

software. 

 The content of this document is subject to change without notice. Please visit the official website 

regularly for the latest information. 


